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CATEGORICAL VARIABLES




il Name

ik Sex Name
A Age

Al Weight .
Al Oxy laracie

4l Runtime Luanne
4l RunPulse
4l RstPulse

4l MaxPulse

Donna

Mirni
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Age
42

Weight

68.15

Oxy Runtime
59.57
60.06
54.30

5463

RunPulse
166
170
156

RstPulse
40
45
45
45

MaxPulse
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|
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186




Summary of Fit

RSquare 0.758967
RSquare Adj 0.741751
Root Mean Square Error 2.707204
Mean of Response 4737581
Observations (or Sum Wgts) 31

Analysis of Variance

Sum of
Source DF Squares Mean Square F Ratio
Model 2 646.17085 323.085 44.0834
Error 28 205.21069 7.329 Prob > F
C. Total 30 851.38154 <.0001*

Parameter Estimates

Term Estimate Std Error tRatio Prob>|t|
Intercept 79.972837 4.215593 1897 <.0001*
Sex|[F] 0.7255551 0.539192 135 0.1892
Runtime -3.081432 039485 -7.80 <.0001*

79.9728367824707
“r 200.7255551433597
+ Match| Sex|| "M"|= -0.7255551433597 0 11 12 13

Runtime
else = |,

+ -3.0814318658011 * Runtime
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Parameter Estimates

Term Estimate Std Error tRatio Prob>|t
Intercept 79972837 4.215593 1897 <.0001* Column Info..

D.f 255551 0.539192 1.25 0D.1B92 standardize Attributes...
Runtime -3081432 0.39485 -7.80 <.0001*

RunPulse RstPulse
166 40

170 A

Column Properties Formula
Modeling Type Motes

8% Sex - IMP Pro Preselect Role Range Check

Formula... List Check
'Sex’ in Table 'Fitness'

COEUV@EX D)
Lock

Color Cells Missing Yalue Codes

Value Labels

Label/Unlabel Value Scores

Scroll Lock/Unlock
Hide/Unhide

Data Type Character ~ Value Orderi

alue Ordering
Modeling Type | Nominal
- Value Colors

e T e B B B B e o e o T £

Column Properties ¥|
Notes Value Ordering

Specify data in the order in which you want the data to appear in
the reports.

Remove

Move. up
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P = ———

— p— Data: Roller Coasters (www.rcdb.com) o
———— Bus Stat 3e JMP File: CE_18

Data Descriptions

- indicates what kind of track the roller coaster has. The possible
values are "wooden" and "steel." (The frame usually is of the same
construction as the track, hut doesn't have to be.)

- Is the duration of the ride in seconds.

- Is top speed in miles per hour.

- IS maximum height above ground level in feet.

- Is greatest drop in feet.

- s total length of the track in feet.

- reports whether riders are turned upside down during the

ride. It has the values "yes" or "no."
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Linear Fit
Duration = 53.934828 + 0.0231084*Length
Summary of Fit

RSquare 0.620265
RSquare Adj 0.61404
Root Mean Square Error 27.23418
Mean of Response 142.2381
Observations (or Sum Wgts) 63
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_
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Analysis of Variance

Sum of
Source DF Squares Mean Square F Ratio
Model 1 73901.71 73901.7 99.6382

Error 61 4524372 741.7 Prob > F
C. Total 62 11914543 <.0001*

Parameter Estimates

Term Estimate Std Error tRatio Prob>|t|
Intercept 53.934828 9.488456 5.68 <.0001* 1000 2000 3000 4000 5000 6000 7000 8000 9000

Length  0.0231084 0.002315 998 <.0001* Length
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Residual by Predicted Plot
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Duration Residual

Duration Predicted

Residual Normal Quantile Plot

80
60
40
20
0
-20
-40
-60

Duration Residual

™M Ln ™~
oS S S

Normal Quantile
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Look at Duration and Length

Graph Builder

56 Duration vs. Length Inversion

— No
— Yes
No

* Yes

c
o
=
o
=
=]
]

2000 3000 4000 5000 6000 7000 8000
Length
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3

~— Fit a model with Duration (Y) Wit Length and Inversion as (X)

Summary of Fit

- RSquare 0.704218
RSquare Adj 0.694359
Root Mean Square Error 24.23531 y
Mean of Response 142.2381 37.4320882497579
Observations (or Sum Wgts) 63

+0.02823930214587 * Length

Analysis of Variance

Sum of "No" = -15.041180332413
Source DF Squares Mean Square F Ratio - . " —
E 60 35241.02 5874
rror Prob > F olee =
C. Total 62 11914543 <.0001*

Parameter Estimates

Term Estimate Std Error tRatio Prob>|t| VIF
Intercept 37432088 9.342736 401 0.0002* .
Length 0.0282393 0.002406 11.74 <.0001* 1.3642357
Inversion[No] -15.04118 3.644784 -413 0.0001* 1.3642357
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RE-CODING CATEGORICAL VARIABLES




Frequencies

Level Count Prob

0 603 0.60300

103 0.10300

63 0.06300

48 0.04800

183 0.18300

Total 1000 1.00000
N Missing 0

5 Levels

Source: German Credit Case
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8 -, Recode - JMP Pro

ol S

4= SAV_ACCT |

OK |

Count Old Value New Value |

Cancel |

603 0

103 1 |Ir'| Place

v

b3 2
48 3
183 4

&= Recode - JMP Pro
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A =ISAV_ACCT

Count Old Value
602 0
102 1
63 2
48 3
185 4

Mew Value | Cancel

|I'*~Iew Column
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INTERACTIONS




) e

Data: Burger King
Bus Stat 3e JMP File: Burger_King CE18

Regression Plot

1000
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e

Data: Burger King
Bus Stat 3e JMP File: Burger_King CE18

Graph Builder

Calories vs. Carbs(g)

wv
@
=
o
]
|9
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_.--—“'--'_—_7

_... We develop a model with carbs and a categorical
s Variable for meat (with and without)

Parameter Estimates

Regression Plot

Term Estimate Std Error tRatio Prob>|t| VIF
Intercept 191.63292 54.23211 3.53 0.0014* :
Carbs(g) 5.9882984 1.138852 526 <.0001* 1.0348528
Meat[0] -150.9572 22.68943 -6.65 <.0001* 1.0348528

1000

800

600

Calories

400
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Residual by Predicted Plot

400 There is more to it than

a categorical variable
SH0 as we can see by the
200 residual by predicted
and also by the
different slopes in the
graph builder
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We adjust for the
slopes by introducing
an

600 800 1000 which is the

Calories Predicted
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Select Columns

g ™' 10 Columns

— thitemn
ﬂSEr'.fingEg]
AlCalories

dlCarbs (g)
ik eat

48 | otal_Fat
ﬂChDIEEternlfmgj
ﬂSDdium(mg]
ﬂSugar:Eg]

AP rotein

Pick Role Vanables

| ¥ | 4l Calories

| weight |

| Freq |
[Validation|

| By |
Construct Model Effects

| Add | |Carbs{g)

at
[ Cross l bsigl*Meat

h =
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Personality: | Standard Least Squares = |

Emphasis: | Effect Leverage - |
| Help | | Run |
| Recall |

Keep dialog open

| Remove |




Regression Plot
o

The interaction term

1000 allows a different slope for
- the two levels of Meat
% 600
5

400 Analysis of Variance

200 Sum of
Source DF Squares Mean Square F Ratio
Model 3 11199792 373326 33.2011
Error 28 314842.7 11244 Prob > F
C. Total 31 14348219 <.0001*

Summary of Fit

Parameter Estimates

RSquare 0.78057 Term Estimate Std Error tRatio Prob>|t| VIF
RSquare Adj 0.75706 Intercept 12431704 4923936 252 0.0175* .
e ot Maan < - Carbs(g) 78708132 1.089746 722 <.0001* 1.3414587
oot Mean Square Error 106.0395 Meat[0] -157.8402 19.16409 -824 <.0001* 1.045179
Mean of Response 4515625 (Carbs(g)-43.4063)*Meat[0] -3.937648 1.089746 -3.61 0.0012* 1.2962797

Observations (or Sum Wgts) 32
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QUADRATIC




- ’ __7_'___,._--*‘—._*
~——Data: Diamonds
Bus Stat 3e JMP File: Diamonds DGK_FE18

4 =ISummary Statistics

7 ':'3'|'-|m”5|l:lear Select| |Di5tri|::|uti|:|r1

Columns N Categories Min Max  Mean 5tdDev
Price : 1000 9903 35845.866 2403658

Color 3 : : : :
Carat_Weight : 0.3000 1.4000 081340 0280201

Clarity ] : : : :
Depth . 56,4000 64,3000 61.69626 1.209758
Table : 53 65 5771686  1.9451

Cut
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4 = Price

10000

9000
8000
7000
6000
5000
4000
3000
2000

4= Color 4> Carat_Weight

14

13
K

1.2

11

1.0

0.9
G

0.8

0.7

0.6

0.5
D

0.4

0.3

A= Clarity

4= Table

67
66
65
64 -
63
62
61
60
58
58

A= Cut

Very Good

13 -
v 56
B 55
57 * 34 Excellent

53
52
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Summary of Fit

RSquare 0.917493
RSquare Adj 0.915919
Root Mean Square Error 696.9819
Mean of Response 3845.866
Observations (or Sum Wgts) 749

Analysis of Variance

Sum of
Source DF Squares Mean Square F Ratio
Model 14 3965059902 283218564 583.0136
Error 734 356565331 485783.83 Prob > F
C. Total 748 4321625233

Actual by Predicted Plot

10000
9000
8000
7000
6000
5000
4000
3000
2000

L]
1000 ®

Price Actual

-1000 1000 3000 5000 7000 9000
Price Predicted P<.0001 RSq=0.92 RMSE=696.98
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Residual by Predicted Plot
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Pick Role Variables
Loy ||

)
ol
~
ez
=}
m
=
kf

Transform the Price
variable by taking Log
(Price)

Effect Tests

haa ] [color Sum of
0 | Source Nparm DF Squares F Ratio Prob > F
Nt | et Color 2 2 3463436 7065080 <.0001*
|D Macros | nooe Carat_Weight 1 1 27363704 1116387 <.0001*
o= | - b Clarity 6 6 2587801 1759622 <.0001*
Tanstom | | Depth 1 1 000382 01560 0.6929
] Table 1 1 0.07323 29878 0.0843
Cut 3 3 0.21/31 2.9552  0.0318*
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Actual by Predicted Plot

10000
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8000
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6000
5000
4000
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Price Actual

[
=

0 2000 4000 6000 8000 10000 12000
Price Predicted P<.0001 RSq=0.94 RMSE=0.1565

Residual by Predicted Plot
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Log(Price) Residual
io

2000 5000 8000 05 08 11 56 58 60 62 52 56 60 64

0 2000 4000 6000 8000 10000 12000

Price Predicted There could be some curvature of
Carat_Weight with Price
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;"U'U' Weight | | Help

I|-C|arit_',.r | Freg | | Recall | Keep dialog open
o ADepth | Validation| | Remove |
ATable e — —_—
- IIICUt | E}r |
™ |adstudentized ..d Loa(Price)
Construct Model Effects Construct Model Ef
| Add || Color . | Add | C
——————————— | Carat_Weight — |4 Pick Role Variabl ]
|  Cross |C|am}, | Cross | ol REERERtATIa S Personality: | Standard Least Squares
| Mest | Cut _— j | v | dLog(Price) Emphasis: | Effect L x
— |Carat_Weight*Carat_Weight | Mest | C - P ' SctLeverage
| Macros = | — (4
Full Factorial | Macros * | -
: | Weight | | Help | |  Run |
Factorial to degree DEgrEE _
Factorial sorted | Freg | | Recall | Keep dialog open
Response Surface |‘-.|‘ali|:|ati|:|r1| | Remove |

Mixture Response Surface s

| By |

Carat_Weight*Carat_Weight
Macros *

Polynomial to Degree I Add the selected columns (say, X}
. and their powers (XX, X*X*X,

Scheffe Cubic to the specified degree. Construct Model Effects

Radial |T| Color
————— | Carat_Weight

: | Cross | Clarity
We create a quadratic term for Nt |[cut

|

Carat_Weight
Degree

Attributes =

Transform =

Mo Intercept
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&=  Summary of Fit
e RSquare

0.97314
RSquare Adj 0.972665
Root Mean Square Error 0.109155
Mean of Response 8.048636
Observations (or Sum Wgts) 749
Analysis of Variance

Sum of

Source DF Squares Mean Square F Ratio
Model 13 317.2839%4 244065 2048.396
Error 735 8.75746 0.0119 Prob > F

C. Total <.0001*

748  326.04140

Multiple Regression - Part 2 | Jim Grayson, PhD



Parameter Estimates

Term
Intercept
Color[D]
Color[G]
Carat_Weight
Clarity[IF]
Clarity[SI1]
Clarity[SI2]
Clarity[VS1]
Clarity[VS2]
Clarity[VVS1]
Cut[Excellent]
Cut[Good]
Cut[Ideal]

(Carat_Weight-0.8134)*(Carat_Weight-0.8134)
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Estimate
5.8094252
0.3397239
0.1206511
2.8241661
0.3939524
-0.266062
-0.419715
0.0225742
-0.102391
0.2150348
0.0217126
-0.067848
0.0589345
-1.611456

Std Error
0.017071
0.006939
0.005837
0.018356
0.014469
0.009108
0.010324
0.010166
0.008994
0.011975
0.007274
0.013406
0.012324

0.05763

t Ratio
340.31
4896
2067
153.85
27.23
-29.21
-40.65
2.22
-11.38
17.96
2.99
-5.06
478
-27.96

Prob> |t|
<.0001*
<.0001*
<.0001*
<.0001*
<.0001*
<.0001*
<.0001*
0.0267*
<.0001*
<.0001*
0.0029*
<.0001*
<.0001*
<.0001*

VIF

1.3145097
1.0430003
1.6608144
2.6973406
1.7797057
2.0378993
1.8122294
1.6992538

2.197911
2.8286118
3.7010049
3.3523403
1.0696919




| Studentized Resid Log(Price)

Residual by Predicted Plot
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Normal Quantile Plot
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Multiple Regression - Part 2 | Jim Grayson, PhD




Multiple Regression - Part 2 | Jim Grayson, PhD 31

TRANSFORMATIONS




Goals of Re-expression *

 Make the distribution of a variable (as seen in its histogram, for
example) more symmetric.

« Make the spread of several groups (as seen in side-by-side boxplots)
more alike

« Make the form of the scatterplot more nearly linear

 Make the scatter in a scatterplot or residual plot spread out evenly
rather than following a fan shape

* pp. 528-530, Business Statistics, 3e, Sharpe, et al (Pearson)
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Table 4-5. Variance-stabilizing transformations

Fower (a) Transformation Comment
None MNormal
Sqguare root Counts

Logarithm Constant percent error

Inverse Rate data

p. 82, DOE Simplified, Anderson and Whitcomb (Productivity Press)

See also p. 531, Business Statistics, 3e by Sharpe, De Veaux and Velleman
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Residual by Predicted Plot
0.4

0.3
0.2
0.1
0.0-r
-0.1
-0.2
-0.3
-04
-0.5
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o
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Log(mpg) Residual

mpg Predicted mpg Predicted
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VARIABLE SELECTION / DIMENSION
REDUCTION

Stepwise




arq,_,s,,e.vera'l"féasons for exercising caution before throwing all possible variables into a model.
Tt may be expensive or not feasible to collect a full complement of predictors for future predictions.

* We may be able to measure fewer predictors more accurately (e.g., in surveys). The more predictors there
are, the higher the chance of missing values in the data. If we delete or impute cases with missing values,
multiple predictors will lead to a higher rate of case deletion or imputation.

» Parsimony is an important property of good models. We obtain more insight into the influence of predictors
in models with few parameters.

» Estimates of regression coefficients are likely to be unstable, due to multicollinearity in models with many
variables. (Multicollinearity is the presence of two or more predictors sharing the same linear relationship
with the outcome variable.) Regression coefficients are more stable for parsimonious models. One very
rough rule of thumb is to have a number of cases n larger than 5(p + 2), where p is the number of
predictors.

» |t can be shown that using predictors that are uncorrelated with the dependent variable increases the
variance of predictions.

» |t can be shown that dropping predictors that are actually correlated with the dependent variable can
increase the average error (bias) of predictions.”

Source: Data Mining for Business Intelligence, 2e by Shmueli, et al (Wiley), p. 127-8.
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jmp.com/learn rev 02/2014

Stepwise Regression

B Use for least squares or logistic regression variable selection, model comparison and model creation.

Stepwise Regression

Example: Car Physical Data.jmp (Help > Sample Data)

A0 T bAratel - B3P

From an open table, select Analyze > Fit Model. 4i% Model Specification
R . Selact Columns Pk Role Warnalas Perzanally | Siepwise
Select a response variable from Select Columns and click Y. — V[ diisepoe

e )
Select predictor variables and click Add. e o | tee pur

. . . -] -‘T'_-II'i'I; Circle el | Recal Kiep clakog apen

If desired, select a validation column (JMP Pro only). Aoisplacement || {abreg | tomave
iz |k e Ly

Select Stepwise from the Personality drop-down menu.

Crorestr o, Mookl Fifes

In the resulting Stepwise Fit window (shown below): fag | Weslt

Turming CGorcke
- [hsplanemicnt
Select a Stopping Rule. Moy | s Tark Size
Maong =

Select the step Direction (forward, backward or mixed). Degree [ 2]

. " " AfrEnnps =
To run the regression automatically, click Ge. To proceed Transfoem =

k0 Inbercepd

manually, click Step.
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Click the red triangle for cross- - Cor Bhysice Dota - it Steme - 117

validation, all possible models
- allp 4 = Stepwise Fit for Horsepower
(all subsets regression), model F o o Use the arrows to step

averaging and other options. Stopping Rule: | Mininum BEIC || Enter All | Make Mode forward or backward.

Direchan Forwara = | #u| Rernewe Al Run Mode
Go Slap Step |

55E DFE RMSE RSquare RSquare Adj cp P AlCc BIC
Results for current model. } GhE14.642 112 24241086 06301 06294 53348455 4 1075296 1088519
A Current Estimates
Lock Entered Parameter Estimate nDF 55 "F Ratie” "Prob=F" - i
Check/uncheck Entered terms Msercent Mep——— g 00w ) P-values are displayed
Vieight 1 1355857 2335 012935 under Prob<F.
o Turning Circle  -3.1848147 1 4838.5M1 2401 000451

to change the model. Locked
terms are used |:|:|r not us.r:'-d] in o Displacement  OL4833ETE 1 3424153 5870 BPe2
o Gas Tank Size 3 6502637 1 841 B3 11.843 00004
later steps. 4Step History

Step Parameter Action "SigProb” 3Seq 55 RSquare Cp

Each time the mgd|:_h| is 1 DeEplacement Entered 0 (IO 10685710 ¢ 05840 18633 2 1087 100D df Use thE rEId-IG bUttDﬂS
o G2z Tank Size Entered 00051 G108852 06120 11836 i

changed, a new line is added —>» 3 Tuming Circle Enfered 00045 4936571 06391 53349 075.3 to select a model.

. Weight Entered 01284 13555 867 1 B4RE o 1075 11 ;

to the Step History panel. . Best Specific 06391 53348
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For Forward regression, remove all terms, then click Step or Go.

For Backward regression, enter all terms, then click Step or Go.

The Mixed direction is only available with the p-value stopping rule.

To run the model shown in the Current Estimates table, click Run Model.
IMP generates a report, including fit statistics and information on
parameter estimates and effect tests. See the Multiple Linear Regression

or Multiple Logistic Regression one-page guides for details.

Note: For additional details search for “stepwise regression” in the JMP Help

or in the Fitting Linear Models book (under Help > Books).
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= Fit Group
¢ = Responas Horeepower
4 Bummary of Fit
RSquare JE3116
RSquare Ad JEZ3440
Raol Kean Soqueres Frron 24241
Bean of Respense 150 1883
Cheanvations jor Sum YWigks) 118
: Analysis of Variance
Sum of

Source OF  Squares Mean Sguare
adel 3 1{GESE.A0 386519
Error M2 GhB14.64 FATE Preb=F

. Talal 15 182370 44

Lack Of Fit
£ Parameter Estimates

Term Estimate 5td Error t Ratio

Imerc oot 1158558 36115992
Turming Circle  -3184615 11021794
Dsphacemant 04933278 0 054626
Gas Tark Size  3EG50284 1.07404a8
Effect Tests

Effect Details

33
-150
7
3

F Ratle

6. 1162

=.0001*

Prebe|t]
Q0o T
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HOUSING PRICES EXAMPLE - AGAIN

Dataset: HousingPrices. | mp




e —
A real estate company that manages properties around a ski resort in the United States

wishes to improve its method for pricing homes. Sample data is obtained on a number of
measures, including size of the home and property, location, age of the house, and a strength-
of-market indicator.

The Data HousingPrices.jmp

The data set contains information on about 45 residential properties near a popular North
American ski resort sold during a recent 12-month period, and is a representative sample of

the full set of properties sold during that time period. The variables in the data set are:

Price: Selling price of the property (in thousands of dollars)

Beds: Number of bedrooms in the house

Baths: Number of bathrooms in the house

Square Feet: Size of the house in square feet

Miles to Resort: Miles from the property to the downtown resort area

Miles to Base: Miles from the property to the base of the skiresort’'s facing
mountain

Acres: Lot size in number of acres
Cars: Number of cars that will fit into the garage
Years Old: Age of the house at the time it was listed in years

DoM: Number of days the house was on the market before it was sold
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H v Model Specification
Select Columns
*'10 Columns

price

AEeds

B aths
dlsquare Feet
Ailes to Resort
dliiles to Base
i cres

ACars

dlyears Old
Do

Pick Role Variables
| ¥ | 4l Price

| Weight |
| Freq |

| Validation |
| By |

Construct Model Effects
Add | Beds
Baths
| Square Feet
T| Miles to Resort
Miles to Base
Acres

Degree 2| Cars
] Years Old
Attributes (= DaM
Transform (=

Cross

Macros *

Mo Intercept
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Personality: | Stepwise

| Help |

| Run

| Recall |

| Remove |

Keep dialeg open




* 4= Stepwise Fit for Price

4 Stepwise Regression Control
Stopping Rule: | Minimum BIC _ |:| | Enter Al | | Make I"u'1|:u:IEI|

Direction: Minimum AlCc |£| |Rernove All| | Run Model |

Stepwise Regression Control

Stopping Rule: | P-value Threshold |:| | Enter All | | Make r".l'1l:ll:|E'||
Prob to Enter 0.25

Prob to Leave 01 | : | |Remove ﬁ'-.II| | Run Model |
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“Two criteria for balancing under-fitting and over-fitting are the
and the

. These criteria measure the information lost by
fitting a given model. Therefore, models with smaller AlIC and
BIC values are considered better. AIC and BIC measure the
goodness of fit (i.e. quality) of a model, but also include a
penalty that is a function of the number of parameters in the
model. As such, they can be used to compare various models

i Y N P [ S | IV R I PR B PR B WY ) | R DY o WS-

TUI LTIT OATTIT UdlA OT L. 1L LAll JT J11IUVvVVIT LThIAl IViAlluvvyo O ‘v MJ 10

equivalent to AIC in the case of multiple linear regression. BIC
applies a larger penalty than AIC does, and may lead to
smaller models.”

Source: Data Mining for Business Intelligence by Shmueli, et al (Wiley)
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Stepwise Fit for Price

—

Stepwise Regression Control

Stopping Rule: |P-value Threshold

Prob to Enter 0.25
Prob to Leave 0.1

Direction: Forward

SSE  DFE RMSE RSquare RSquare Adj Cp P AlCc BIC
153342.58 40 61915785  0.8018 0.7820 1.3287813 5 507.9345 516.564

Current Estimates

Lock Entered Parameter Estimate nDF SS "F Ratio” "Prob>F"
Intercept 197.150171 0 0.000 1
Beds 0 1148.056 0.294 0.59063
Baths 59.2080973 4638791 12.100 0.00123
Square Feet 0.05112326 19597.28 5.112 0.02927
Miles to Resort 0 1735.229 0.446 0.508
Miles to Base -3.7985104 9077452 23679 1.81e-5
Acres 5.00610917 46854.78 12.222 0.00117
Cars 0 311.3432 0.079  0.77968
Years Old 0 969.519 0.248 062118
DoM 0 408.8354 0.104 0.7485

O0OJO0ONAMONRNOMN
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O
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O
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Step History

Step Parameter Action “Sig Prob™” SeqSS RSquare Cp AlCc BIC
1 Baths Entered 0.0000 495319 0.6402 2494 527.135 53197 O
2 Miles to Base Entered 0.0015 59830.74 0.7176 12.765 518.659 524.885 O
3 Acres Entered 0.0021 4555833 0.7765 3.9716 510.675 518.169 O
4 Square Feet Entered 0.0293 1959728 0.8018 1.3288 507.935 516.564 @
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o' = Stepwise Fit for Price

4 Stepwise Regression Control

Stopping Rule: | Minimum BIC - D|:| | Enter All | | Make Mndell

Direction: |Forward | |;| |Remove All| | Run Model |

| Go ||)Stn:u|::l || Step |

S5E DFE RMSE RSquare RS5quare Adj Cp p AlCc BIC
773647.92 44 13260056 -0.000 -0.0000 1402869 1 570.839 5741672

4 Current Estimates

Lock Entered Parameter Estimate nDF 55 "F Ratio™ "Prob=F"
Intercept 391.191111 0 0.000 1
Beds 3528164 36050 36le-7
Baths 495319 76.524 43e-11
Square Feet 3758904 40.636 1.04e-7
Miles to Resort 2248396 17.617 0.00013
Miles to Base 3102201 2B8.784 304e-6
4864029 0.027 0.87013
158295.3 11.0&81 0.00181
9754987 6.204 0.01668
40869.88 2.398 01288

Acres
Cars
Years Old
DaoM

(= R = =N =N = = = =
L S T =R R o S S S S
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BIC
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S5E  DFE RMSE RSquare RSquare Adj Cp p AlCc
153342.58 40 61.915785  0.8018 07820 13287813 5 507.9345 516.564
4 Current Estimates
Lock Entersd—Parameter Estimate nDF 55 "FRatio” "Prob>F"
Intercept 197.150171 1 0 0.000 1
Beds 0 1 1148056 0.294  0.59063
v Baths 59.2080973 1 4638791 12100  0.00123
v Square Feet 005112326 1 19587.28 5112 0.02927
Miles to Resort 0 1 1735.229 0.446 0.508
v Miles to Base  [-3.7985104 1 9077452 23679 1.8le-5
v Acres 500610017 1 46854.78 12222 000117
Cars 0 1 311.3432 0079 077968
Years Old 0 1 969.519 0.248 062118
0 1 408.5354 0.104 0.7485
4 StepHistory
Step Parameter Action "Sig Prob™ 5eq55 RSquare Cp p AlCc BIC
1 Baths Entered 0.0000 495319  0p402 2454 2 527135 53197
2 Milesto Base Entered 0.0015 5983074 07176 12765 3 518659 524885
3 Acres Entered 0.0021 4555833 07765 39716 4 510675 518168
4 Sguare Feet  Entered 0.0293 1959728 08018 13288 5 507935 516.564
5 Al Removed : : -0.000 14029 1 570.84 574167
6  Baths Entered 0.0000 495319  0p402 2494 2 527135 53197
7 Milesto Base Entered 0.0015 5983074 00176 12765 3 518659 524.835
8 Acres Entered 0.0021 4555833 09765 39716 4 510675 518169
9  Sguare Fest  Entered 0.0293 19597.28 08018 13283 5 507935 516.564
10 Miles to Resert Entered 0.5080 1735229 08040 29177 & 510.239 519.858
11 Years Old Entered 0.5013 1816724  0.B064 44873 7 512669 523123
12 Beds Entered 0.7110 5623105 08071 63541 & 515643 526.76
13 Cars Entered 0.5854 1245656 08087 8.058% O 518594 53019
14 Dobd Errtered L1 o B L S VR = H—t—522047 53392
15  Best Specific 08018 13288 5 507.935 516564 @

‘4‘

|| | Enter Al |(Make Model|

|+h| |Fler'r1|:|*.reﬁull| | Run Model |




=~ Model Specification
Select Columns

=10 Columns
dprice
dlBeds
AEaths
l5quare Feet
dliiles to Resort
liiles to Base
licres
ACars
dlears Old
Do
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Pick Reole Wariables
| ¥ | 4l Price

| Weight |

| Freq |

| Validation |

| By |

Construct Maodel Effects

Add | Baths
Square Feet

|
| Cross | Miles to Base
|
|

Mest | Acres

Macros = |

Personality: | Standard Least Squares

-

Emphasis: | Effect Leverage

-
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Summary of Fit

0.801793
0.781972
61.91579
391.1911

45

RSquare

RSquare Adj

Root Mean Square Error
Mean of Response
Observations (or Sum Wgts)

Analysis of Variance

Sum of

Source DF
Model 4

40
44

Squares Mean Square F Ratio
620305.34 155076 404523

153342.58 3834 Prob > F
773647.92 <.0001*

Error
C. Total




